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	 9	 Creating Dynamic 
		  Worksheets by Using  
		  PivotTables
In this chapter, you will learn how to
✔	 Analyze data dynamically by using PivotTables.
✔	 Filter, show, and hide PivotTable data.
✔	 Edit PivotTables.
✔	 Format PivotTables.
✔	 Create PivotTables from external data.

When you create Microsoft Excel 2010 worksheets, you must consider how you want the 
data to appear when you show it to your colleagues. You can change the formatting of 
your data to emphasize the contents of specific cells, sort and filter your worksheets based 
on the contents of specific columns, or hide rows containing data that isn’t relevant to the 
point you’re trying to make.

One limitation of the standard Excel worksheet is that you can’t easily change how 
the data is organized on the page. For example, in a worksheet in which each column 
represents an hour in the day, each row represents a day in a month, and the body of 
the worksheet contains the total sales for every hourly period of the month, you can’t 
change the worksheet quickly so that it displays only sales on Tuesdays during the 
afternoon.

There is an Excel tool with which you can create worksheets that can be sorted, filtered, 
and rearranged dynamically to emphasize different aspects of your data. That tool is the 
PivotTable.
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In this chapter, you’ll learn how to create and edit PivotTables from an existing work-
sheet, focus your PivotTable data using filters and Slicers, format PivotTables, and  
create a PivotTable with data imported from a text file.

Practice Files  Before you can complete the exercises in this chapter, you need to copy 
the book’s practice files to your computer. The practice files you’ll use to complete the 
exercises in this chapter are in the Chapter09 practice file folder. A complete list of 
practice files is provided in “Using the Practice Files” at the beginning of this book.

Analyzing Data Dynamically by Using PivotTables
With Excel worksheets you can gather and present important data, but the standard work-
sheet can’t be changed from its original configuration easily. As an example, consider a 
worksheet that records monthly package volumes for each of nine distribution centers in 
the United States. 

Troubleshooting  The appearance of buttons and groups on the ribbon changes depending 
on the width of the program window. For information about changing the appearance of 
the ribbon to match our screen images, see “Modifying the Display of the Ribbon” at the 
beginning of this book.



The data in the worksheet is organized so that each row represents a distribution center 
and each column represents a month of the year. When presented in this arrangement, 
the monthly totals for all centers and the yearly total for each distribution center are 
given equal billing: neither set of totals stands out.

Such a neutral presentation of your data is versatile, but it has limitations. First, although 
you can use sorting and filtering to restrict the rows or columns shown, it’s difficult to 
change the worksheet’s organization. For example, in this worksheet, you can’t easily 
reorganize the contents of your worksheet so that the months are assigned to the rows 
and the distribution centers are assigned to the columns.

The Excel tool to reorganize and redisplay your data dynamically is the PivotTable. You 
can create a PivotTable, or dynamic worksheet, that enables you to reorganize and filter 
your data on the fly. For instance, you can create a PivotTable with the same layout as 
the worksheet described previously, which emphasizes totals by month, and then change 
the PivotTable layout to have the rows represent the months of the year and the columns 
represent the distribution centers. The new layout emphasizes the totals by regional 
distribution center.
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To create a PivotTable, you must have your data collected in a list. Excel tables mesh 
perfectly with PivotTable dynamic views; not only do Excel tables have a well-defined 
column and row structure, but the ability to refer to an Excel table by its name also 
greatly simplifies PivotTable creation and management.

In the Excel table used to create the distribution PivotTable, each row of the table con-
tains a value representing the distribution center, date, month, week, weekday, day, and 
volume for every day of the years 2009 and 2010.

Excel needs that data when it creates the PivotTable so that it can maintain relation-
ships among the data. If you want to filter your PivotTable so that it shows all package 
volumes on Thursdays in January, for example, Excel must be able to identify January 11 
as a Thursday.

After you create an Excel table, you can click any cell in the table, display the Insert tab 
and then, in the Tables group, click PivotTable to open the Create PivotTable dialog box.



In this dialog box, you verify the data source for your PivotTable and whether you want to 
create a PivotTable on a new worksheet or an existing worksheet. After you click OK, Excel 
displays a new or existing worksheet and displays the PivotTable Field List task pane.

Tip  You should always place your PivotTable on its own worksheet to avoid cluttering the 
display.
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If the PivotTable Field List task pane isn’t visible, you can display it by clicking any cell in 
the PivotTable to display the PivotTable Tools contextual tabs. On the Options contextual 
tab, in the Show/Hide group, click Field List.

To assign a field, or column of data, to an area of the PivotTable, drag the field header 
from the Choose Fields To Add To Report area at the top of the PivotTable Field List task 
pane to the Drag Fields Between Areas Below area at the bottom of the task pane. For 
example, if you drag the Volume field header to the Values area, the PivotTable displays 
the total of all entries in the Volume column. 



It’s important to note that the order in which you enter the fields in the Row Labels 
and Column Labels areas affects how Excel organizes the data in your PivotTable. As an 
example, consider a PivotTable that groups the PivotTable rows by distribution center 
and then by month.
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The same PivotTable data could also be organized by month and then by distribution 
center.

In the preceding examples, all the field headers are in the Row Labels area. If you drag 
the Center header from the Row Labels area to the Column Labels area, the PivotTable 
reorganizes (pivots) its data to form a different configuration.



To pivot a PivotTable, you drag a field header to a new position in the PivotTable Field List 
task pane. As you drag a field within the task pane, Excel displays a blue line in the interior 
of the target area so you know where the field will appear when you release the left mouse 
button. If your data set is large or if you based your PivotTable on a data collection on 
another computer, it might take some time for Excel to reorganize the PivotTable after a 
pivot. You can have Excel delay redrawing the PivotTable by selecting the Defer Layout 
Update check box in the lower-left corner of the PivotTable Field List task pane. When 
you’re ready for Excel to display the reorganized PivotTable, click Update.

If you expect your PivotTable source data to change, such as when you link to an external 
database that records shipments or labor hours, you should ensure that your PivotTable 
summarizes all the available data. To do that, you can refresh the PivotTable connection 
to its data source. If Excel detects new data in the source table, it updates the PivotTable 
contents accordingly. To refresh your PivotTable, click any cell in the PivotTable and then, 
on the Options contextual tab, in the Data group, click Refresh.
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In this exercise, you’ll create a PivotTable by using data from a table, add fields to  
the PivotTable, and then pivot the PivotTable.

SET UP  You need the Creating_start workbook located in your Chapter09 practice 
file folder to complete this exercise. Start Excel, open the Creating_start workbook, 
and save it as Creating. Then follow the steps. 

	 1.	 Click any cell in the Excel table.

	 2.	 On the Insert tab, in the Tables group, click the PivotTable button (not the arrow).

The Create PivotTable dialog box opens.

	 3.	 Verify that the DailyVolumes table name appears in the Table/Range field and 
that the New Worksheet option is selected.

	 4.	 Click OK.

Excel creates a PivotTable on a new worksheet.

	 5.	 In the PivotTable Field List task pane, drag the Center field header to the Row 
Labels area.

Excel adds the Center field values to the PivotTable row area.



	 6.	 In the PivotTable Field List task pane, drag the Year field header to the Column 
Labels area.

Excel adds the Year field values to the PivotTable column area.

	 7.	 In the PivotTable Field List task pane, drag the Volume field header to the 
Values area.

Excel fills in the body of the PivotTable with the Volume field values.

	 8.	 In the PivotTable Field List task pane, in the Column Labels area, drag the 
Year field header to the Row Labels area, and drop it beneath the Center field 
header.

Excel changes the PivotTable to reflect the new organization.

CLEAN UP  Save the Creating workbook, and then close it.
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Filtering, Showing, and Hiding PivotTable Data
PivotTables often summarize huge data sets in a relatively small worksheet. The more 
details you can capture and write to a table, the more flexibility you have in analyzing 
the data. As an example, consider all the details captured in a table in which each row 
contains a value representing the distribution center, date, month, week, weekday, day, 
and volume for every day of the year.

Each column, in turn, contains numerous values: there are nine distribution centers, 
data from two years, 12 months in a year, seven weekdays, and as many as five weeks 
and 31 days in a month. Just as you can filter the data that appears in an Excel table 
or other data collection, you can filter the data displayed in a PivotTable by selecting 
which values you want the PivotTable to include.

See Also  For more information on filtering an Excel table, see “Limiting Data That Appears on 
Your Screen” in Chapter 5, “Focusing on Specific Data by Using Filters.”



To filter a PivotTable based on a field’s contents, click the field’s header in the Choose 
Fields To Add To Report area of the PivotTable Field List task pane. When you do, Excel 
displays a menu of sorting and filtering options.

The PivotTable displays several sorting options, commands for different categories of 
filters, and a list of items that appear in the field you want to filter. Every list item has a 
check box next to it. Items with a check mark in the box are currently displayed in the 
PivotTable, and items without a check mark are hidden. 

The first entry at the top of the item list is the Select All check box. The Select All check 
box can have one of three states: displaying a check mark, displaying a black square,  
or empty. If the Select All check box contains a check mark, then the PivotTable dis-
plays every item in the list. If the Select All check box is empty, then no filter items are 
selected. Finally, if the Select All check box contains a black square, it means that some, 
but not all, of the items in the list are displayed. Selecting only the Northwest check box, 
for example, leads to a PivotTable configuration in which only the data for the Northwest 
center is displayed.
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If you’d rather display as much PivotTable data as possible, you can hide the PivotTable 
Field List task pane and filter the PivotTable by using the filter arrows on the Row Labels 
and Column Labels headers within the body of the PivotTable. Clicking either of those 
headers enables you to select a field by which you can filter; you can then define the 
filter by using the same controls you see when you click a field header in the PivotTable 
Field List task pane.

Excel indicates that a PivotTable has filters applied by placing a filter indicator next to the 
Column Labels or Row Labels header, as appropriate, and the filtered field name in 
the PivotTable Field List task pane.



So far, all the fields by which we’ve filtered the PivotTable have changed the organiza-
tion of the data in the PivotTable. Adding some fields to a PivotTable, however, might 
create unwanted complexity. For example, you might want to filter a PivotTable by 
weekday, but adding the Weekday field to the body of the PivotTable expands the 
table unnecessarily.

Instead of adding the Weekday field to the Row Labels or Column Labels area, you can 
drag the field to the Report Filter area near the bottom of the PivotTable Field List task 
pane. Doing so leaves the body of the PivotTable unchanged, but adds a new area above 
the PivotTable in its worksheet.
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Tip  In Excel 2003 and earlier versions, this area was called the Page Field area.

When you click the filter arrow of a field in the Report Filter area, Excel displays a list of 
the values in the field. When you click the filter arrow, you can choose to filter by one 
value at a time. If you’d like to filter your PivotTable by more than one value, you can 
do so by selecting the Select Multiple Items check box.

If your PivotTable has more than one field in the Row Labels area, you can filter values 
in a PivotTable by hiding and collapsing levels of detail within the report. To do that, 
you click the Hide Detail control (which looks like a box with a minus sign in it) or the 
Show Detail control (which looks like a box with a plus sign in it) next to a header.  



For example, you might have your data divided by year; clicking the Show Detail control 
next to the 2009 year header would display that year’s details. Conversely, clicking the 
2010 year header’s Hide Detail control would hide the individual months’ values and 
display only the year’s total.

Excel 2010 provides two new ways for you to filter PivotTables: search filters and Slicers. 
With a search filter, you can type in a series of characters for Excel to filter that field’s 
values. To create a search filter, click a field’s filter arrow and type the character string 
for which you want to search in the filter menu’s Search box.
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For example, if the PivotTable’s Center field contains the values Atlantic, Central, Midwest, 
Mountain West, North Central, Northeast, Northwest, Southeast, and Southwest, typing 
the character string “No” limits the values to North Central, Northeast, and Northwest.

Tip  Search filters look for the character string you specify anywhere within a field’s value, 
not just at the start of the value. In the previous example, the search filter string “cen” would 
return both Central and North Central.

In versions of Excel prior to Excel 2010, the only visual indication that you had applied a 
filter to a field was the indicator added to a field’s filter arrow. The indicator told users  
that there was an active filter applied to that field but provided no information on 
which values were displayed and which were hidden. In Excel 2010, Slicers provide a 
visual indication of which items are currently displayed or hidden in a PivotTable. 



To create a Slicer, click any cell in a PivotTable and then, on the Options contextual tab 
of the ribbon, in the Sort & Filter group, click Insert Slicer to display the Insert Slicers 
dialog box.

Select the check box next to the fields for which you want to create a Slicer, and click OK. 
When you do, Excel 2010 displays a Slicer for each field you identified.
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Tip  If you have already applied a filter to the field for which you display a Slicer, the Slicer 
reflects the filter’s result.

A Slicer displays the values within the PivotTable field you identified. Any value displayed in 
color (or gray if you select a gray-and-white color scheme) appears within the PivotTable. 
Values displayed in light gray or white do not appear in the PivotTable. 

Clicking an item in a Slicer changes that item’s state—if a value is currently displayed in 
a PivotTable, clicking it hides it. If it’s hidden, clicking its value in the Slicer displays it 
in the PivotTable. As with other objects in an Excel 2010 workbook, you can use the Shift 
and Ctrl keys to help define your selections. For example, suppose you create a Slicer for 
the Month field while every month is displayed.



If you want to hide every month except January, February, and March, you click the 
January item to hide every month except January. Then hold down the Shift key 
and click March to have Excel 2010 display just the data for the months of January, 
February, and March. You can then add another month, such as July, to the filter by 
holding down the Ctrl key and clicking July in the Slicer.
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To use a Slicer to remove a filter, click the Clear Filter button in the upper-right corner of 
the Slicer. If you want to resize a Slicer, you can do so by dragging the resize handle in the 
lower-right corner of the Slicer. To hide the Slicer, right-click it and then click the menu 
command that starts with the word “Remove.” For example, the Month field’s menu com-
mand would be Remove Month.

Tip  You can change a Slicer’s formatting by clicking the Slicer and then, on the Slicer Tools 
Options contextual tab on the ribbon, clicking a style in the Slicer Styles gallery.

In this exercise, you’ll focus the data displayed in a PivotTable by creating a filter, by filter-
ing a PivotTable based on the contents of a field in the Report Filters area, by showing and 
hiding levels of detail within the body of the PivotTable, by using the Search box, and by 
using Slicers.

SET UP  You need the Focusing_start workbook located in your Chapter09 practice 
file folder to complete this exercise. Open the Focusing_start workbook, and save it 
as Focusing. Then follow the steps. 

	 1.	 On the Sheet2 worksheet, click any cell in the PivotTable.

	 2.	 In the PivotTable Field List task pane’s Choose fields to add to report area, 
click the Center field header, click the Center field filter arrow, and then clear the 
(Select All) check box.



Excel clears all the check boxes in the filter menu.

	 3.	 Select the Northwest check box, and then click OK.

Excel filters the PivotTable.

	 4.	 On the Quick Access Toolbar, click the Undo button.

Excel removes the filter.

	 5.	 In the PivotTable Field List task pane, drag the Weekday field header from the 
Choose fields to add to report area to the Report Filter area in the Drag fields 
between areas below area.

	 6.	 In the PivotTable Field List task pane, click the Close button.

The PivotTable Field List task pane closes.

	 7.	 In the body of the worksheet, click the Weekday filter arrow, and then, if necessary, 
select the Select Multiple Items check box.

Excel adds check boxes beside the items in the Weekday field filter list.

	 8.	 Clear the All check box.

Excel clears each check box in the list.
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	 9.	 Select the Tuesday and Thursday check boxes, and then click OK.

Excel filters the PivotTable, summarizing only those values from Tuesdays and 
Thursdays.

	 10.	 In cell A5, click the Hide Detail button.

Excel collapses rows that contain data from the year 2009, leaving only the subtotal 
row that summarizes that year’s data.

	 11.	 In cell A5, click  the Show Detail button.

Excel redisplays the collapsed rows.

	 12.	 On the ribbon, click the Options contextual tab, and then, in the Show group, click 
Field List.

The PivotTable Field List task pane opens.

	 13.	 In the PivotTable Field List task pane, click the Month field header arrow.

The filter menu opens.



	 14.	 In the Search box, type Ju.

Excel displays the months June and July in the filter list.

	 15.	 Click OK.

Excel applies the filter.

	 16.	 On the Options contextual tab of the ribbon, in the Actions group, click the Clear 
button, and then click Clear Filters.

Excel clears all filters from the PivotTable.

	 17.	 On the Options contextual tab of the ribbon, in the Sort & Filter group, click 
Insert Slicer.

The Insert Slicers dialog box opens.

	 18.	 In the Insert Slicers dialog box, select the Center check box, and then click OK.

A Slicer for the Center field appears.

	 19.	 Click the Atlantic item.

Excel filters the PivotTable so only results for the Atlantic center appear.
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	 20.	 In the Slicer, click Midwest, and then, while holding down the Ctrl key, click 
Mountain West and then Northwest.

Excel filters the PivotTable so it displays results for the Midwest, Mountain West, 
and Northwest centers.

	 21.	 In the upper-right corner of the Slicer, click the Clear Filter button.

Excel removes the filter from the Center field.

	 22.	 Right-click the Slicer, and then click Remove "Center".

Excel closes the Slicer.

CLEAN UP  Save the Focusing workbook, and then close it.

Editing PivotTables
After you create a PivotTable, you can rename it, edit it to control how it summarizes your 
data, and use the PivotTable cell data in a formula. As an example, consider a PivotTable 
named PivotTable2 that summarizes package volumes for every Consolidated Messengers 
regional distribution hub.



Excel displays the PivotTable name on the Options contextual tab, in the PivotTable 
Options group. The name PivotTable2 doesn’t help you or your colleagues understand 
the data the PivotTable contains, particularly if you use the PivotTable data in a formula 
on another worksheet. To give your PivotTable a more descriptive name, click any cell in 
the PivotTable and then, on the Options contextual tab, in the PivotTable Options group, 
type the new name in the PivotTable Name field.

When you create a PivotTable with at least one field in the Row Labels area and one field 
in the Column Labels area of the PivotTable Field List task pane, Excel adds a grand total 
row and column to summarize your data. You can control how and where these sum-
mary rows and columns appear by clicking any PivotTable cell and then, on the Design 
contextual tab, in the Layout group, clicking either the Subtotals or Grand Totals button 
and selecting the desired layout.

After you create a PivotTable, Excel determines the best way to summarize the data in the 
column you assign to the Values area. For numeric data, for example, Excel uses the SUM 
function. If you want to change a PivotTable summary function, right-click any data cell in 
the PivotTable values area, point to Summarize Values By, and then click the desired opera-
tion. If you want to use a function other than those listed, click More Options to display the 
Value Field Settings dialog box. On the Summarize Values By page of the dialog box, you 
can choose the summary operation you want to use.
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You can also change how the PivotTable displays the data in the Values area. On the Show 
Values As page of the Value Field Settings dialog box, you can select whether to display 
each cell’s percentage contribution to its column’s total, its row’s total, or its contribution 
to the total of all values displayed in the PivotTable.

If you want, you can create a formula that incorporates a value from a PivotTable cell. 
To do so, you click the cell where you want to create the formula, type an equal sign, 
and then click the cell in the PivotTable that contains the data you want to appear in the 
other cell. A GETPIVOTDATA formula appears in the formula box of the worksheet that 
contains the PivotTable. When you press Enter, Excel creates the GETPIVOTDATA formula 
and displays the contents of the PivotTable cell in the target cell.



In this exercise, you’ll rename a PivotTable, specify whether subtotal and grand total rows 
will appear, change the PivotTable summary function, display each cell’s contribution to 
its row’s total, and create a formula that incorporates a value in a PivotTable cell.

SET UP  You need the Editing_start workbook located in your Chapter09 practice 
file folder to complete this exercise. Open the Editing_start workbook, and save it 
as Editing. Then follow the steps.

	 1.	 On the Sheet2 worksheet, click any cell in the PivotTable.

	 2.	 On the Options contextual tab, in the PivotTable group, in the PivotTable Name 
field, type VolumeSummary and press Enter.

Excel renames the PivotTable.

	 3.	 On the Design contextual tab, in the Layout group, click Subtotals, and then click 
Do Not Show Subtotals.

Excel removes the subtotal rows from the PivotTable.

	 4.	 On the Design contextual tab, in the Layout group, click Grand Totals, and then 
click On for columns only.

Excel removes the cells that calculate each row’s grand total.
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	 5.	 On the Quick Access Toolbar, click the Undo button.

Excel reverses the last change.

	 6.	 Right-click any data cell in the PivotTable, point to Summarize Values By, and then 
click Average.

Excel changes the Value field summary operation.

	 7.	 On the Quick Access Toolbar, click the Undo button.

Excel reverses the last change.

	 8.	 Right-click any data cell in the PivotTable, and then click Value Field Settings.

The Value Field Settings dialog box opens.

	 9.	 Click the Show Values As tab.

The Show Values As page appears.

	 10.	 In the Show Values As list, click % of Row Total.

	 11.	 Click OK.

Excel changes how it calculates the values in the PivotTable.



	 12.	 On the Quick Access Toolbar, click the Undo button.

Excel reverses the last change.

	 13.	 On the Design tab, in the Layout group, click Subtotals, and then click Show All 
Subtotals at Bottom of Group.

Excel displays subtotals in the workbook.

	 14.	 Click the Package Summary sheet tab.

The Package Summary worksheet appears.

	 15.	 In cell C4, type =, but do not press Enter.

	 16.	 Click the PivotTable sheet tab.

The PivotTable worksheet appears.

	 17.	 Click cell K32, and then press Enter.

Excel creates the formula =GETPIVOTDATA(“Volume”,PivotTable!$A$3,”Year”,2010) 
in cell C4.
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CLEAN UP  Save the Focusing workbook, and then close it.

Formatting PivotTables
PivotTables are the ideal tools for summarizing and examining large data tables, even 
those containing more than 10,000 or even 100,000 rows. Even though PivotTables often 
end up as compact summaries, you should do everything you can to make your data more 
comprehensible. One way to improve your data’s readability is to apply a number format 
to the PivotTable Values field. To apply a number format to a field, right-click any cell in the 
field, and then click Number Format to display the Format Cells dialog box. Select or define 
the format you want to apply, and then click OK to enact the change.

See Also  For more information on selecting and defining cell formats by using the Format 
Cells dialog box, see “Formatting Cells” in Chapter 4, “Changing Workbook Appearance.”

Analysts often use PivotTables to summarize and examine organizational data with an 
eye to making important decisions about the company. For example, chief operating 
officer Lori Penor might examine monthly package volumes handled by Consolidated 
Messenger and notice that there’s a surge in package volume during the winter months 
in the United States.



Excel extends the capabilities of your PivotTables by enabling you to apply a conditional 
format to the PivotTable cells. What’s more, you can select whether to apply the condi-
tional format to every cell in the Values area, to every cell at the same level as the selected 
cell (that is, a regular data cell, a subtotal cell, or a grand total cell) or to every cell that 
contains or draws its values from the selected cell’s field (such as the Volume field in the 
previous example).

To apply a conditional format to a PivotTable field, click a cell in the Values area. On the 
Home tab, in the Styles group, click Conditional Formatting, and then create the desired 
conditional format. After you do, Excel displays a Formatting Options action button, 
which offers three options for applying the conditional format:

●	 Selected Cells  Applies the conditional format to the selected cells only

●	 All Cells Showing Sum of field_name Values  Applies the conditional format to every 
cell in the data area, regardless of whether the cell is in the data area, a subtotal row 
or column, or a grand total row or column

●	 All Cells Showing Sum of field_name Values for Fields  Applies the conditional 
format to every cell at the same level (for example, data cell, subtotal, or grand 
total) as the selected cells
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See Also  For more information on creating conditional formats, see “Changing the 
Appearance of Data Based on Its Value” in Chapter 4, “Changing Workbook Appearance.”

In Excel, you can take full advantage of the Microsoft Office system enhanced formatting 
capabilities to apply existing formats to your PivotTables. Just as you can create Excel 
table formats, you can also create your own PivotTable formats to match your organi-
zation’s desired color scheme.

To apply a PivotTable style, click any cell in the PivotTable and then, on the Design con-
textual tab, in the PivotTable Styles group, click the gallery item representing the style 
you want to apply. If you want to create your own PivotTable style, click the More button 
in the PivotTable Styles gallery (in the lower-right corner of the gallery), and then click 
New PivotTable Style to display the New PivotTable Quick Style dialog box.

Type a name for the style in the Name field, click the first table element you want to cus-
tomize, and then click Format. Use the controls in the Format Cells dialog box to change 
the element’s appearance. After you click OK to close the Format Cells dialog box, the New 
PivotTable Quick Style dialog box Preview pane displays the style’s appearance. If you want 
Excel to use the style by default, select the Set As Default PivotTable Quick Style For This 
Document check box. After you finish creating your formats, click OK to close the New 
PivotTable Quick Style dialog box and save your style.



The Design contextual tab contains many other tools you can use to format your PivotTable, 
but one of the most useful is the Banded Columns check box, which you can find in the 
PivotTable Style Options group. If you select a PivotTable style that offers banded rows as 
an option, selecting the Banded Rows check box turns banding on. If you prefer not to have 
Excel band the rows in your PivotTable, clearing the check box turns banding off.

In this exercise, you’ll apply a number format to a PivotTable values field, apply a PivotTable 
style, create your own PivotTable style, give your PivotTable banded rows, and apply a con-
ditional format to a PivotTable.

SET UP  You need the Formatting_start workbook located in your Chapter09 practice 
file folder to complete this exercise. Open the Formatting_start workbook, and save it 
as Formatting. Then follow the steps. 

	 1.	 On the Sheet2 worksheet, right-click any data cell, and then click Number Format.

The Format Cells dialog box opens.

	 2.	 In the Category list, click Number.

The Number page is displayed.
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	 3.	 In the Decimal places field, type 0.

	 4.	 Select the Use 1000 Separator (,) check box.

	 5.	 Click OK.

Excel reformats your PivotTable data.

	 6.	 If necessary, on the Design contextual tab, in the PivotTable Style Options group, 
select the Banded Rows check box.

	 7.	 On the Design contextual tab, in the PivotTable Styles group, click the More 
button. Then, in the top row of the gallery, click the third style from the left. 
(When you point to it, Excel displays a ScreenTip that reads Pivot Style Light 2.)



Excel applies the PivotTable style.

	 8.	 In the lower-right corner of the PivotTable Styles gallery, click the More button.

The gallery expands.

	 9.	 Click New PivotTable Style.

The New PivotTable Quick Style dialog box opens.
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	 10.	 In the Name field, type Custom Style 1.

	 11.	 In the Table Element list, click Header Row, and then click Format.

The Format Cells dialog box opens.

	 12.	 On the Font page, in the Color list, click the white square.

	 13.	 On the Border page, in the Presets area, click Outline.

	 14.	 On the Fill page, in the Background Color area, click the purple square at the 
lower-right corner of the color palette.

	 15.	 Click OK.

The Format Cells dialog box closes, and the style change appears in the Preview 
pane of the New PivotTable Quick Style dialog box.

	 16.	 In the Table Element list, click Second Row Stripe, and then click Format.

The Format Cells dialog box opens.

	 17.	 On the Fill page, in the middle part of the Background Color area, click the 
eighth square in the second row (it’s a light, dusty purple).

	 18.	 Click OK twice.



The Format Cells dialog box closes, and your format appears in the PivotTable 
Styles gallery.

	 19.	 Click the new style.

Excel formats your PivotTable using your custom PivotTable style.

	 20.	 On the Design contextual tab, in the PivotTable Style Options group, clear the 
Banded Rows check box.

Excel removes the banding from your PivotTable and from the preview of the 
custom style.
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	 21.	 Select the cell ranges K6:K17 and K19:K30.

	 22.	 On the Home tab, in the Styles group, click Conditional Formatting, point to 
Color Scales, and in the top row, click the second three-color scale from the left.

Excel applies the conditional format to the selected cells.

CLEAN UP  Save the Formatting workbook, and then close it.

Creating PivotTables from External Data
Although most of the time you will create PivotTables from data stored in Excel worksheets, 
you can also bring data from outside sources into Excel. For example, you might need 
to work with data created in another spreadsheet program with a file format that Excel 
can’t read directly. Fortunately, you can export the data from the original program into a 
text file, which Excel then translates into a worksheet.



Tip  The data import technique shown here isn’t exclusive to PivotTables. You can use this 
procedure to bring data into your worksheets for any purpose.

Spreadsheet programs store data in cells, so the goal of representing spreadsheet data in 
a text file is to indicate where the contents of one cell end and those of the next cell begin. 
The character that marks the end of a cell is a delimiter, in that it marks the end (or “limit”) 
of a cell. The most common cell delimiter is the comma, so the delimited sequence 15, 18, 
24, 28 represents data in four cells. The problem with using commas to delimit financial 
data is that larger values—such as 52,802—can be written by using commas as thousands 
markers. To avoid confusion when importing a text file, the most commonly used delimiter 
for financial data is the Tab character.

To import data from a text file, on the Data tab, in the Get External Data group, click 
From Text to display the Import Text File dialog box.
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From within the Import Text File dialog box, browse to the directory that contains  
the text file you want to import. Double-clicking the file launches the Text Import 
wizard.

On the first page of the Text Import wizard, you can indicate whether the data file you 
are importing is Delimited or Fixed Width; Fixed Width means that each cell value will fall 
within a specific position in the file. Clicking Next to accept the default choice, Delimited 
(which Excel assigns after examining the data source you selected), advances you to the 
next wizard page.



On this page, you can choose the delimiter for the file (in this case, Excel detected tabs in 
the file and selected the Tab check box for you) and gives you a preview of what the text 
file will look like when imported. Clicking Next advances you to the final wizard page.
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On this page, you can change the data type and formatting of the columns in your data. 
Because you’ll assign number styles and PivotTable Quick Styles after you create the 
PivotTable, you can click Finish to import the data into your worksheet. After the data is 
in Excel, you can work with it normally.

In this exercise, you’ll import data into Excel from a text file and then create a PivotTable 
based on that data.

SET UP  You need the Creating_start text file located in your Chapter09 practice file 
folder to complete this exercise. 

	 1.	 Create a new Excel workbook. On the Data tab, click the Get External Data button, 
and then click From Text.

The Import Text File dialog box opens.

	 2.	 Navigate to the Chapter09 practice file folder, and then double-click 
Creating_start.txt.

The Text Import wizard starts.

	 3.	 Verify that the Delimited option is selected, and then click Next.

The next Text Import Wizard page opens.

	 4.	 In the Delimiters area, verify that the Tab check box is selected and also verify 
that the data displayed in the Data preview area reflects the structure you 
expect.

	 5.	 Click Finish.

Clicking Finish skips page 3 of the wizard, which has commands you can use 
to assign specific data types to each column. Excel assigns data types for you, 
so you don’t need to do so. After you click Finish, the Import Data dialog box 
opens.



	 6.	 Verify that the Existing worksheet option is selected, and then click OK.

Excel imports the data into your workbook.

	 7.	 On the Home tab, in the Styles group, click Format as Table, and then click the 
first table style.

The Format As Table dialog box opens.

	 8.	 Verify that the My table has headers check box is selected and that the range 
=$A$1:$H$6571 appears in the Where is the data for your table? box, and 
then click OK.

A confirmation dialog box opens.

	 9.	 Click Yes to confirm you want to create the Excel table and break its link to the 
external data source.

Excel creates an Excel table from your imported data.

	 10.	 On the Insert tab, in the Tables group, click PivotTable.

The Create PivotTable dialog box opens.

	 11.	 Verify that the Select a table or range option is selected, that Table1 appears in 
the Table/Range field, and that the New Worksheet option is selected.

	 12.	 Click OK.

Excel creates the PivotTable on a new worksheet.

	 13.	 In the PivotTable Field List task pane, drag the Volume field header to the 
Values area.

	 14.	 Drag the Weekday field header to the Column Labels area.

	 15.	 Drag the Center field header to the Row Labels data area.
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	 16.	 On the Quick Access Toolbar, click the Save button.

The Save As dialog box opens.

	 17.	 Browse to the Chapter09 folder.

	 18.	 In the File name field, type ImportedData.

	 19.	 Click Save.

Excel saves your file.

CLEAN UP  Close the Imported Data workbook. If you’re not continuing directly to 
the next chapter, exit Excel.



Key Points
●	 A PivotTable is a versatile tool you can use to rearrange your data dynamically, 

enabling you to emphasize different aspects of your data without creating new 
worksheets.

●	 PivotTable data must be formatted as a list. By using a data table as the PivotTable 
data source, you can streamline the creation process by referring to the table name 
instead of being required to select the entire range that contains  
the data you want to summarize.

●	 Excel comes with many attractive styles for PivotTables; you’ll probably find one 
you like.

●	 With the PivotTable Field List task pane, you can create your PivotTable by using 
a straightforward, compact tool.

●	 Just as you can limit the data shown in a static worksheet, you can use filters to 
limit the data shown in a PivotTable.

●	 Excel 2010 includes two new types of filters, search filters and Slicers, that you can 
use to limit the data in your PivotTables.

●	 If you have data in a compatible format, such as a text file, you can import that 
data into Excel and create a PivotTable from it.
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